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Notices 
Copyright 
Copyright © 2022 Quantum Northwest, Inc. All 
rights reserved.  
No part of this publication may be reproduced, 
transmitted, transcribed, stored in a retrieval 
system, or translated into any language, in any 
form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without prior 
written permission from Quantum Northwest, Inc. 
All copyright, confidential information, patents, 
design rights and all other intellectual property 
rights of whatsoever nature contained herein are 
and shall remain the sole and exclusive property of 
Quantum Northwest, Inc. The information furnished 
herein is believed to be accurate and reliable. 
However, no responsibility is assumed by Quantum 
Northwest, Inc. for its use, or for any infringements 
of patents or other rights of third parties resulting 
from its use. 
The Quantum Northwest name, QNW acronym and 
Quantum Northwest logo are trademarks or 
registered trademarks of Quantum Northwest, Inc.  
All other trademarks are the property of their 
respective owners. 
Quantum Northwest products must only be used in 
the manner described in the Quantum Northwest 
produce user guides.  Any other use may result in 
damage to the product or personal injury.  
Quantum Northwest is not responsible for any 
damages caused, in whole or in part, by improper 
use of the products, unauthorized alterations, 
adjustments or modifications to the products, 
failure to comply with procedures in Quantum 
Northwest product user guides, or use of the 

products in violation of applicable laws, rules or 
regulations.  Quantum Northwest shall not be liable 
for errors or damages on products or performance 
due to using non-Quantum Northwest genuine 
parts.  

Warranty  
The material contained in this document is 
provided “as is,” and is subject to being changed, 
without notice, in future editions. Further, to the  
maximum extent permitted by applicable law, 
Quantum Northwest disclaims all warranties, either 
express or implied, with regard to this manual and 
any information contained herein, including but not 
limited to the implied warranties of merchantability 
and fitness for a particular purpose. Quantum 
Northwest shall not be liable for errors or for 
incidental or consequential damages in connection 
with the furnishing, use, or performance of this 
document or of any information contained herein. 
Should Quantum Northwest and the user have a 
separate written agreement with warranty terms 
covering the material in this document that conflict 
with these terms, the warranty terms in the 
separate agreement shall control.  

Technology Licenses  
The hardware and/or software described in this 
document are furnished under a license and may 
be used or copied only in accordance with the 
terms of such license. 

Safety Notices 
CAUTION  

Q u a n t u m  N o r t h w e s t ,  I n c .  
22910 E Appleway Avenue, Suite 4 

Liberty Lake, WA 99019-8606 

Phone: (509) 624-9290 
Fax: (509) 624-9488 

Service email: service@qnw.com 

w w w . q n w . c o m  

T e m p e r a t u r e - C o n t r o l l e d  C u v e t t e  H o l d e r s  
a n d  C u s t o m  I n s t r u m e n t a t i o n  



 
 

  9/21/2022  
  

Page 3 of 45 

QNW TC 1B User’s Guide 

A CAUTION notice denotes a hazard. It calls 
attention to an operating procedure, practice, or the 
like that, if not correctly performed or adhered to, 
could result in damage to the product or loss of 
important data. Do not proceed beyond a 
CAUTION notice until the indicated conditions are 
fully understood and met. 

WARNING  

A WARNING notice denotes a hazard. It calls 
attention to an operating procedure, practice, or the 
like that, if not correctly performed or adhered to, 
could result in personal injury or death. Do not 
proceed beyond a WARNING notice until the 
indicated conditions are fully understood and met. 
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1. General Information 
Thank you for purchasing a Quantum Northwest TC 1 Temperature Controller and associated Peltier-
controlled cuvette holder. We want you to enjoy many years of faithful service from your instrument. If you 
have any questions, feel free to contact us directly through our website, www.qnw.com/contact-us/, or by 
email at service@qnw.com. 

Your Quantum Northwest temperature controller and associated cuvette holder have been carefully designed 
so that when used properly, you have an accurate, fast, flexible and safe temperature control system.  

Information about safety practices appears throughout the documentation provided with your instrument and 
accessories to help you safely operate the instrument and accessories. Before using the instrument or 
accessories, you must thoroughly read these safety practices. ALWAYS operate the instrument and 
accessories in accordance with these safety practices. 

1.1. User Documentation 
You have been provided with the following documentation to help you set up and operate your Quantum 
Northwest TC 1B Temperature Controller:  

• This manual, with safety practices and hazards information, instructions for installing and maintaining 
the components of the QNW TC 1B Temperature Controller and troubleshooting information. 

• The T-App Help file, located on the T-App CD, if purchased (Quantum Northwest>T-App Help). 

1.2. Other Precautions 
Do not block any ventilation grills present on the QNW TC 1B Temperature Controller. 
Use of the QNW TC 1B Temperature Controller and accessories may involve materials, solvents and 
solutions that are flammable, corrosive, toxic or otherwise hazardous. Careless, improper, or unskilled use of 
such materials, solvents and solutions can create explosion hazards, fire hazards, toxicity and other hazards 
which can result in death, serious personal injury, and damage to equipment and property.  

ALWAYS ensure that laboratory safety practices governing the use, handling and disposal of such materials 
are strictly observed. These safety practices should include the wearing of appropriate safety clothing and 
safety glasses. 

1.3. Warning and Other Symbols 
The following is a list of symbols that appear in conjunction with warnings on the QNW cuvette holder and 
accessories. The hazard they describe is also shown.  

A triangular symbol indicates a warning. The meanings of the symbols that may appear alongside warnings in 
the documentation or on the instrument itself are as follows.  
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When used on a warning label, the user is in 
danger of an electrical shock. 

 

When used on warning labels attached to the 
instrument, refer to the relevant operation or 
service manual for the correct procedure referred 
to by that warning label. 

 

When attached to the rear of the instrument, 
indicates that the product complies with the 
requirements of one or more EU directives. 

 

1.4. CE Compliance 
Your QNW TC 1B Temperature Controller has been designed to comply with the requirements of the 
Electromagnetic Compatibility (EMC) Directive and the Low Voltage (electrical safety) Directive (commonly 
referred to as the LVD) of the European Union.  

Proof that a product complies with these directives is indicated by:  

• the CE Marking appearing on the rear of the product, and  

• the following Declaration of Conformity. The Declaration of Conformity is the legal declaration by 
Quantum Northwest that the product complies with the directives to demonstrate compliance.  



 
 

  9/21/2022  
  

Page 8 of 45 

QNW TC 1B User’s Guide 

          EU Declaration of Conformity 
 
We:  Quantum Northwest, Inc. 
Of:  22910 E Appleway Ave, Suite 4 
  Liberty Lake, WA 99019-8606 
  USA 
Hereby declare under our sole responsibility that the following devices: 
 

QNW MODEL (CONTROLLER MODEL)  
Bath 10 TC 1 Controller (qX2x2™) 
TC 1 Temperature Controller TC 1 Controller (qX3™) 
TC 1 Controller (CD 250™) TC 1 Controller (t2 Sport™) 
TC 1 Controller (CD 350™) TC 1 Controller (t2x2 Sport™) 
TC 1 Controller (Cyl 100™) TC 1 Controller (Brr 20™) 
TC 1 Controller (Flash 300™) TC 1 Controller (Brr 30™) 
TC 1 Controller (Luma 40™) TC 1 Controller (Turret 4™) 
TC 1 Controller (qpod®) TC 1 Controller (Turret 6™) 
TC 1 Controller (QUANTICS™) TC 1 Controllers (Neutron Sample Holders) 
TC 1 Controller (qX2™) TC 1 Controller (qX-Ray 1000™) 

 

Comply with the essential requirements of the following applicable European Directives: 

Electromagnetic Compatibility (EMC) Directive 2014/30/EU,  
Low-Voltage Directive 2014/35/EU,  
RoHS Directive 2015/863/EU. 

 
 
I hereby declare that the equipment models named above have been assessed and found to comply with 
the relevant sections of the above-referenced specifications.  The units comply with the relevant 
requirements of the applicable Legislation, and I am the person authorized to compile the technical 
documentation. 
 
Signed by:  

Name:  Enoch W. Small, Ph.D. 
Position: President, Quantum Northwest, Inc. 
Date:  May 25, 2020 
Location: Liberty Lake, Washington, USA 
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Declaration of Conformity to EU Directive 2015/863/EU (RoHS) 
 
We:  Quantum Northwest, Inc. 
Of:  22910 E Appleway Ave, Suite 4 
  Liberty Lake, WA 99019-8606, USA 
   
Declare under our sole responsibility that our products indicated below are in fully compliance with EU 
Directive 2015/863/EU, with respect to the following substances: 

1. Lead (Pb), 
2. Mercury (Hg), 
3. Cadmium (Cd), 
4. Hexavalent chromium (Cr (VI)), 
5. Polybrominated biphenyls (PBB), 
6. Polybrominated diphenyl ethers (PBDE). 
7. Bis(2‐ethylhexyl) phthalate (DEHP) 
8. Benzyl butyl phthalate (BBP) 
9. Dibutyl phthalate (DBP) 
10. Diisobutyl phthalate (DIBP) 

 
QNW MODEL (CONTROLLER MODEL)  
Bath 10 TC 1 Controller (qX2x2™) 
TC 1 Temperature Controller TC 1 Controller (qX3™) 
TC 1 Controller (CD 250™) TC 1 Controller (t2 Sport™) 
TC 1 Controller (CD 350™) TC 1 Controller (t2x2 Sport™) 
TC 1 Controller (Cyl 100™) TC 1 Controller (Brr 20™) 
TC 1 Controller (Flash 300™) TC 1 Controller (Brr 30™) 
TC 1 Controller (Luma 40™) TC 1 Controller (Turret 4™) 
TC 1 Controller (qpod®) TC 1 Controller (Turret 6™) 
TC 1 Controller (QUANTICS™) TC 1 Controllers (Neutron Sample Holders) 
TC 1 Controller (qX2™) TC 1 Controller (qX-Ray 1000™) 

 

The following statement regarding conformity of our products to the EU Directive 2015/863/EU (RoHS) is 
based on our actual research and inquiries with our suppliers: 

All products sold under the above model numbers previously, currently and in future are/will be 
fully compliant with EU Directive 2015/863/EU and without exemption. 

 

Signed by:  

Name:  Enoch W. Small, Ph.D. 
Position: President, Quantum Northwest, Inc. 
Date:  February 24, 2021 
Location: Liberty Lake, Washington, USA 



 
 

  9/21/2022  
  

Page 10 of 45 

QNW TC 1B User’s Guide 

 

 

 

 

 

 

 

 

 

 

1.5. Introduction: QNW TC 1B Temperature Controller 
Intended Use 

The QNW TC 1B Temperature Controller is used with an associated Peltier-controlled cuvette holder to 
control sample temperature during optical measurements.  Temperature control is achieved using the TC 1B 
Temperature Controller alone or along with a computer interfaced to the TC 1B Temperature Controller 
box, using the QNW T-App software provided. 

1.6. Measurement Category 
The measurement category is IEC 61010:I. Do not to use this equipment for measurements within 
measurement categories II, III and IV. 

1.7. Pollution Degree 
The pollution degree is IEC61010:2. Pollution degree “2” applies to a normal indoor atmosphere. 

1.8. Overvoltage Category 
The overvoltage category (installation category) is CAT II. See IEC 664 & IEC 61010. 

1.9. Environmental Conditions 
The area should have a dust-free atmosphere with minimal drafts, vibrations, and corrosive fumes. For 
optimum performance, the ambient air is recommended to be between 20 and 25 °C, but can be from 5 to 40 
°C. Relative humidity should be less than 80%. The instrument is designed for operation at 2,000 m elevation 
or less. 

Figure 1. TC 1B Temperature Controller 
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To avoid damage through spillage of solutions and samples being analyzed, the worktops should be covered 
with a material that is corrosion resistant and impervious to liquids.  

Allow at least two inches of space on both sides, and six inches at the rear of the instruments to permit free 
air circulation. The power cord and all other connections are located at the rear of the instruments. The power 
switch is located on the front panel.  

1.10. Electrical Specifications 
Mains Supply 

A standard power cable is provided based on the user’s country requirements (18 AWG/115 V AC 
US/Canada; 1.0 mm/220 V AC international). The required supply voltage is 100-240 V AC (frequency 50 or 
60 Hz). The mains voltage fluctuations must not exceed 10% of the nominal voltage. 

The installation of electrical power supplies must comply with the rules and/or regulations imposed by local 
authorities responsible for the supply of electrical energy to the workplace. 

All power supplies for the TC 1B Temperature Controller must be single-phase, AC voltage, three-wire 
system (active, neutral, earth) and should be terminated at an appropriate power outlet receptacle that is 
within reach of the power cord. For safety reasons, a separate power outlet receptacle should be provided for 
each unit in the system. The use of extension cords or outlet adaptors is not recommended. 

 

WARNING  

Shock Hazard - Danger of electrocution. Good electrical grounding is essential to avoid 
potentially serious shock hazards. A 3-wire outlet with ground connection must be provided for 
the TC 1B Temperature Controller. Make certain that power outlets are earth-grounded at the 
grounding pin.  

 

CAUTION 
 

Caution - Never connect or disconnect any cables while the TC 1B Temperature Controller is 
switched on. Damage to the printed circuit boards may occur. 

 

 

1.11. Computer Requirements 
The T-App temperature application software used for external control of Quantum Northwest temperature 
controllers requires a personal computer using a Microsoft Windows™ operating system (10, XP, Vista, 7, or 
8). The T-App software is normally provided on a CD, requiring a CD player be part of the computer. 
However, T-App may also be downloaded via the Internet from a QNW ftp site.  Contact QNW should you 
wish to obtain the application by Internet. 
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2. Installing, Starting and Stopping the QNW 
TC 1B Temperature Controller 

2.1. Installing the QNW TC 1B Temperature Controller 
Unpacking 

After accepting delivery, take the equipment to the installation site. Quantum Northwest instruments are 
inherently robust, and the packaging is designed to prevent internal damage. However, the contents form part 
of a precision measuring system and all packages should be handled with care. In transit, sharp jolts must be 
avoided and the packages should not be inverted or tilted unnecessarily. Markings on the shipping cartons 
generally indicate which side of the package should be kept on top.  

Unpacking the equipment is your responsibility. As the packages are opened, ensure that you have received 
everything you ordered. If there are any discrepancies, notify the supplier. If any items are found to be 
damaged, immediately notify the carrier and supplier.   

You should have received:  

• 1x TC 1B Temperature Controller 

• 1x power cable 

• 1x USB cable 

• 1x CD containing T-App software (if ordered) 

• This manual 

Note:  Any additional items ordered are not listed here. 

Any differences from the original order should be referred immediately to your Quantum Northwest sales 
office. Do not discard any packaging components or filler materials. 

 

Installing the QNW T-App Software (if ordered) 
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1. Follow the instructions provided with the software to complete the installation.  The instructions are 
found in a text file titled “Instructions.txt” within the T-App folder.  Those instructions will be similar to 
the following: 

2.  

Note:  It is important to install software before connecting the TC 1B to your computer.  Software 
installation installs a driver.  If the TC 1B Temperature Controller is connected to the computer 
and turned on before software installation, then the computer may automatically load an 
incorrect driver that may be difficult to remove. 

3. Connect the TC 1B to your computer using the USB or RS 232 cable provided.  The New Hardware 
installation process will begin automatically and take a few moments to finish. 

 

 

Installing the QNW TC 1B Temperature Controller Hardware 

1. Install the Peltier-controlled cuvette holder into the destination spectrometer.  

Note:  The TC 1B Temperature Controller and its associated Peltier-controlled cuvette holder are 
supplied completely assembled.  It is necessary only to make the appropriate connections. 

 

 

 

 

 
 

2. If you did not purchase the low 
temperature option, then skip to step 5. For 
operation below 0.0 °C, circulating water or 
other coolant fluid is required to remove heat 
from the Peltier heat exchanger.  

 

Figure 2. Example of a submersible pump, 
bucket, electrical cable, and vinyl tubing to 
be used with the TC 1 Temperature 
Controller and associated Peltier-controlled 
cuvette holder for low temperature operation. 

Instruction for installation of T-App 
1. Copy the "T-App" folder to a convenient location on the computer to be used. 

2. Run "CDM v2.12.12 WHQL Certified.exe" to the install drivers needed for serial 
communications between the QNW TC 1 temperature controller and the T-App application. 

3. Connect the TC 1B to the computer to be used with the USB cable provided with the TC 1B (or 
any USB cable with the correct plug ends).  Turn on the TC 1 power.  Installation of the drivers for 
the USB connection should begin immediately and proceed automatically. 

4. Run "T-App.exe".  For further information select the Help>(T-App Help) menu item. 
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3. Position the bucket to within 75 cm (30 in) above or below the spectrometer. 
CAUTION 

 

Caution – Position the bucket in a location that minimizes the risk of spilling the liquid contents. 

 

4. Cut the vinyl tubing into two lengths (three if you will be using the dry gas purge). Attach one length 
of tubing from the hose barb of the submersible pump, shown in Fig. 2, to either one of the water 
hose barbs on the Peltier-controlled cuvette holder, labeled “water access for thermoelectric cooler.” 
Attach another piece of tubing from the second cuvette holder water hose barb to the bucket to serve 
as a drain tube. Add water to the bucket and lower the pump into the bucket, making sure that the 
pump is below the water line. Using the electrical cable from the pump, connect the pump to the 
socket on the back of the TC 1B Temperature Controller. The pump will start automatically when 
the TC 1B power is turned on later. 

5. OPTIONAL - If a gas such as nitrogen is to be used as dry gas for minimizing condensation at low 
temperatures, secure the tank to a solid object in the vicinity of the spectrometer. 

CAUTION 
 

Caution – When using dry gas do prevent condensation on the cuvette, ensure that the working 
area is adequately ventilated. 

 

6. OPTIONAL - If you plan to work at low temperatures, connect a source of dry gas (typically nitrogen) 
to release upon the cuvette windows. Attach a length of tubing with 1/16-inch inside diameter to the 
small dry gas hose barb on the base of the Peltier-controlled cuvette holder.  Set the dry gas flow 
rate to about 50 cc/min. 

7. Connect the electrical cable from the cuvette holder to the 15-pin, VGA-type connector labeled 
“Sample” on the back of the TC 1B Temperature Controller. 

8. Plug the power cable into the back of the TC 1B Temperature Controller and into a wall socket.   

2.2. Starting the QNW TC 1B Temperature Controller 
9. Place the magnetic stir bar in a standard 1 x 1-cm square cuvette. Insert a liquid sample into the 

cuvette. 

10. Place the cuvette in the cuvette holder. 

11. Place the plastic lid on the cuvette holder. 
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12. OPTIONAL - If you wish to monitor the temperature inside the cuvette, plug the Probe/10k-qX into 
the side of the cuvette holder.  Place the end of the probe in a region of the sample in the cuvette 
where it will not occlude the spectrometer light beam. The temperature read by the probe will 
automatically appear on the screen of the temperature controller. 

13. Turn on the TC 1B controller using the switch on the back panel.  On the TC 1B front panel, press 
once on the right-arrow button and once on the SET button.  If you are using a Bath 10 for low 
temperature studies, these two steps turn on the pump by turning on the temperature control.  (The 
pump runs only when the temperature control is turned on). 

14. If you are using the Bath 10, check for water leaks. Also check that water is flowing from the free 
tubing end.  If it does not, lift the pump off the bottom of the bucket, but not out of the water, and drop 
it.  This usually will get the flow started.  If it does not after several tries, lift the pump up close to the 
water surface and let a small drop of liquid detergent land in the water close to the pump intake. 

15. For now, turn the TC 1B power off. 
 

 

 

       

Figure 3. TC 1B Menu Button 

16. Use the left or right arrows on the Menu Button, shown in Fig. 3, to cycle through the four pages of 
options.  These options are described in detail in Section 2.3 below. To turn on stirring and set a 
temperature, go to the Set Stirring page, use the up and down arrows to set a speed or let it default 
to 1200 rpm, and press SET to start the stirrer.  Then go to the Set Target Temperature page and 
use the up and down arrows to set a target temperature, for example, 37.0 °C.  Press SET to initiate 
temperature control.  The temperature will then change and stabilize.  

Figure 3. The Probe/10k-qX is a thermistor probe 
for use with the qX2, qX2x2 and qX3 products. 
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2.3. Stopping the QNW TC 1B Temperature Controller 
 

1. While temperature control is running and the Start page is being displayed, press SET (Fig. 3) to turn 
off temperature control.  To turn off stirring, go to the Set Stirrer page and press SET again. 

2. After measurements are completed, turn off power on the back of the TC 1B controller. 
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3. Step-by-Step Instructions for Using the 
QNW TC 1B Temperature Controller 

3.1. Instrument Overview 
The TC 1B Temperature Controller may be used in a stand-alone manner together with its associated 
Peltier-controlled cuvette holder, or under PC control using QNW’s T-App software or other vendors’ 
software. 

T-App is a program that permits external computer control of the TC 1B Temperature Controller.  The 
temperature of the sample holder and a temperature sensed by an external probe may be plotted vs time.  
Simple text scripts may be used to automate multiple operations.  T-App is provided with a USB cable to 
connect your computer to the TC 1B.  Full instructions for using T-App may be found in the associated Help 
file. 

3.2. Detailed Instructions 
Using the Menu Button control arrows 

 

 

 

       

Figure 4. TC 1B Menu Button control arrows 

Refer to Fig. 7 for the appearance of the TC 1B Menu button.  Use the right and left arrows to cycle through 
four pages: 

– Display – Set Target Temperature – Set Stirring – Set Ramping –   

Display 

 
  

Holder =  37.0 °C    
Target =  37.0 °C      
Probe  =  36.9 °C   
Ramp On   Stir On   
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Figure 5. Example TC 1B Display page for a single cuvette holder and external probe, with temperature  

Display: This main page shows the actual cuvette Holder temperature, the Target temperature and a Probe 
temperature (if a probe is present).  The page also shows whether the Ramp and Stir functions are on or off.  
After a few seconds of inactivity, all other pages will revert back to the Display page. 

When seeking a temperature, the green LED on the front panel will flash slowly.  When the cuvette holder 
has locked onto a new target temperature, the green LED will remain lit.  A rapidly flashing red LED usually 
means a loose electrical cable or inadequate water flow for the Peltier unit. 

Note: Pressing the SET button while the Display page is active results in no action.  To start or stop 
controller functions, access the four other pages, Set Target Temperature – Set Stirring – Set 
Ramping – Set Position. 

Set Target Temperature 

 

Figure 6. TC 1B Set Target Temperature page 

Set Target Temperature: To set the Target temperature, use the up and down arrows.  Press SET to 
retain this new Target and initiate temperature control.  The green LED light will begin flashing slowly as the 
device seeks the targeted temperature, and the page window will show the Current to be ON.   

Discontinue Temperature Control: Press SET while the green LED light is lit or slowly flashing to 
discontinue temperature control.  The LED light will turn off completely, and the page window will show the 
Current to be Off. 

Set Stirring 

 
Figure 7. TC 1B Set Stirring page 

 

Set Stirring 
 
Stir speed = 1200 rpm 
Current = Off 

  

  
  

  
  

 

Set Target Temp. 
  
Target =  37.0 °C 
Current=  23.6 °C Off 
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Set Stirring: To turn on magnetic Stirring, use the up and down arrows to choose an approximate stirring 
speed between 200 and 2000 rpm.  Press SET to set the speed and initiate stirring.  The page will update to 
show the Current value to be the same as Stir speed. 

Discontinue Stirring: Press SET while the Stirring is on (shown by nonzero Current rpm) to turn the 
stirrer off.  The page will update to show the Current speed to be Off. 

Set Ramping 

 

Figure 8. TC 1B Set Ramping page 

Set Ramping: To perform a temperature ramp, set the Ramp rate using the up and down arrows, and press 
SET.  The page will update to show the Current rate in °/min to be the same as the Ramp rate. With ramping 
set, turning on temperature control will generate a linear ramp to the target temperature.  When the sample 
holder reaches the target temperature, no further temperature change occurs, although the Current rate will 
remain as set. 

The fastest possible ramp is determined by how fast the cuvette holder is able to reach the target 
temperature without ramping.  Attempting to ramp too quickly, especially at high and low temperature 
extremes, will result in a nonlinear ramp.  The slowest ramp that may be set on this page is 0.09 °C/minute.  
(If needed, much slower ramps may be set through software commands.) 

Discontinue Ramping: Press SET while the Ramp is on (shown by nonzero Current °/min) to turn the Ramp 
off.  The page will update to show the Current rate to be Off. 

3.3. External Computer Control 
All functions may be accessed either through a Serial (RS 232) or a USB located on the back of TC 1B 
Temperature Controller.  You may write your own program or purchase the QNW application program T-
App.  T-App will plot temperatures of the probe, cuvette tower, and even the Peltier element heat exchanger 
vs time.  It will also permit you to set up temperature ramps.  If you wish to do your own programming, please 
see the Appendix for communication instructions and the set of text commands that may be used and 
responses to the commands. 

 

Set Ramping 
 
Ramp = 0.55°/min 
Current = Off 
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3.4. Troubleshooting 
If you are using a submersible pump that has operated without being immersed in water, it may not prime 
properly.  If this occurs, place one drop of detergent on the pump intake and try again. 

If the TC 1B display indicates that there is inadequate coolant, it may be that the circulating water is too 
warm. Add ice to the water to cool it down. 

If a cuvette shorter than 44 mm is used, it may be difficult to remove. Use a taller cuvette instead. 

3.5. Error Messages 
When errors occur, the line 1 of the TC 1B Temperature Controller display presents an error code.  Line 3 of 
the display identifies the error and line 4 of the display presents possible solutions. The most common events 
that cause errors to be displayed are loose cables or inadequate coolant flow.  For errors not easily solved, 
contact QNW at www.qnw.com/contact-us/ or service@qnw.com. 

Specific error messages include the following. 

 
5 – cell out of range 

warnings: loose cable, sensor failure 

The temperature controller is not receiving a reasonable response from the sensor on the cuvette tower.  
Either the sensor has failed or a cable is not making a good connection. 

 
6 – cell out of range 

warnings: loose cable, check cable 

The temperature controller is not receiving reasonable responses from either the cell tower or heat exchanger 
sensors.  Since it is very unlikely for both to fail, probably a cable is loose. 

 
7 – heat exchanger error 

warnings: loose cable, sensor failure 

The temperature controller is not receiving a reasonable response from the sensor on the heat exchanger.  
Either the sensor has failed or a cable is not making a good connection. 

 
8 – inadequate coolant 

warnings: inadequate coolant, water temperature 

The sensor on the heat exchanger is reading a temperature above 60 °C.  Temperature control has been 
shut down to prevent damage to the Peltier element.  Either the water was too warm or the rate of flow was 
inadequate to draw sufficient heat from the heat exchanger. 
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9 – Invalid command 

The controller has been sent an invalid text command. 
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4. Maintenance and Spare Parts 

4.1. Maintenance 
The TC 1B Temperature Controller requires very little routine maintenance on the part of the user.  For 
routine cleaning of exposed surfaces, use only a cloth dampened with water or diluted detergent.  Do not use 
organic or abrasive solvents. 

CAUTION 
 

Caution – Any action which makes it necessary to open the TC 1B Temperature Controller unit 
must be executed only by QNW technicians or authorized personnel. 

 

The water hoses and the submersible pump should be inspected prior to each usage to ensure that they are 
intact. Replace the nylon tubing when it becomes discolored or cracked. Periodically replace the water stored 
in the bucket to minimize the growth of microorganisms.  When not in use, the pump, bucket, and tubing may 
be stored dry. 

4.2. Spare Parts 
Vinyl tubing and magnetic stir bars may be obtained from a variety of commercial vendors.  For electrical 
cables to be used with TC 1B Temperature Controller and submersible pumps, please contact QNW at 
service@qnw.com. 

mailto:service@qnw.com
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5. Serial Communications for the TC 1B 
Temperature Controller 

 

2/5/2016 

Note:  This document provides the serial communications protocols for version 2.2 of the firmware 
on the TC 1 and TC 1B family of controllers. 

TC 1/Single – for single cuvette holders such as the t2 Sport, Versa 20, Luma 40, CD 250 and Flash 300; 

TC 1/Dual – for dual independent control for sample and reference cuvettes of the t2x2 Sport and Versa 
Dual; 

TC 1/Multi – for multi-position sample changers such as the qCHANGER 6 and the Turret 6. 

TC 1B/Single – for the single, air-cooled cuvette holders qX2 and qX3 

TC 1B/Dual – for the dual, air-cooled qX2x2 

The version number and the ID (see below) are shown briefly on the display when the temperature controller 
is turned on.  This initial display can be repeated by pressing the down arrow on the front panel of the 
controller. 

All functions of the temperature controller can be managed from a computer, using the command set 
described below.  If you purchased your unit as a component of a spectrometer from certain manufacturers, 
this feature may be implemented through traditional RS232 serial connectors on the computer, or the 
spectrometer and on the controller.  In this case they will be connected by a standard 15-pin serial extension 
cable (male connector on one end and female on the other).  No driver installation should be needed. 
Otherwise the serial linkage will be established through a USB connection between the computer and the 
controller.  In this case the controller includes electronics which convert the USB connection to a serial 
communications port.  However, for the port to be available to programs on the computer, it will be necessary 
to load driver software.   
 
CAUTION 

 

Caution - It is important that the driver software be loaded before connecting a USB cable 
between the controller and the computer.  Contact Quantum Northwest for further information. 

 
Quantum Northwest offers the T-App control program written specifically for control of all functions of the 
temperature controller and to track temperature as a function of time.  The resulting data can be saved to a 
text file (two columns, time and temperature, tab delimited) or copied and pasted directly into another 
program (such as Microsoft Excel).  If you expect to create software or firmware that communicates with a TC 
1 or TC 1B controller, T-App may prove extremely useful for preliminary testing of controller commands. 
 
In programming for the TC 1 or TC 1B controller, one must adhere to the conventional notation: 8/N/1. 
 Baud:  19200 
 Data Bits:  8 
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 Parity:  None 
 Stop Bit:  1 
 Flow Control: None 

For many of the commands listed below, the controller returns information in response to the command.  All 
commands and responses are delineated by left and right square brackets ( [  ] ).  Any text sent to the 
controller not enclosed within brackets will be ignored.  In this document, an ellipsis (…) is used to distinguish 
responses from commands. 

Note:  The format of the commands is shown below. 

 
[command] Purpose of the command (sent to the controller). 
...[response] Meaning of the response (received from the controller). 

 
 

5.1. Sample Holder ID Number 
[F1 ID ?] What is the ID number of the sample holder being controlled?  
...[F1 ID 114] ID is 114. 
 
      

Assigned Identities:  
ID = 00 specialty sample holder (see command class 14) 
 114 single 
 24 dual 
 34 turret or linear multi-sample holder 

5.2. Controller Firmware Version 
[F1 VN ?] What is the Version Number of the controller firmware? 
...[F1 VN 2.6.04] The controller firmware version number is 2.6.04. 

5.3. Stirrer 
[F1 MS ?] What is the Maximum stirrer Speed? 
...[F1 MS 2500] The maximum stirrer speed permitted is 2500 rpm. 
[F1 LS ?] What is the Lowest stirrer Speed? 
...[F1 MS 300] The lowest stirrer speed permitted is 300 rpm. 
[F1 SS S 1000] Set Stirrer Speed to 1000 rpm and turn stirring on. 
[F1 SS S 0] Turn stirrer off (does not change the speed setting). 
[F1 SS +] Turn stirrer on and set it to the most recent non-zero stirrer speed setting. 
[F1 SS -] Turn stirrer off (this does not change the speed setting).. 
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[F1 SS ?] What is the current stirrer speed setting?  Depending on the R+/R- state as 
specified below, the stirrer status (’+’/on or ’-’/off) may also be reported. 

...[F1 SS 1000] Stirrer speed setting is 1000 rpm. 

...[F1 SS -] Stirrer status is off. 
[F1 SS R-] Turn off automatic Reporting of the stirrer speed and status when changed by a 

command. 
[F1 SS R+] Turn on automatic reporting of stirrer changes. 

The power on default setting is to not report the speed or the status when 
changed. 

If you then send [F1 SS R+], only the stirring speed will be reported when 
changed. 

If you then send [F1 SS R+], both the speed and the status will be reported when 
changed. 

If you then send [F1 SS R-], neither the speed nor the status will be reported when 
changed (back to the power on default setting). 

Note that the [F1 SS ?] will always result in a stirring speed response.  The status 
response will also be sent if it has been enabled as described above. 

5.4. Temperature Control 
[F1 TC +] Turn Temperature Control on. 
[F1 TC -] Turn temperature control off. 
[F1 TC ?] What is the current status of temperature control? 
...[F1 TC -] Temperature control status is ‘-‘/off. 
[F1 TC R+] Report temperature control status when changed by a command. 
[F1 TC R-] Do not report temperature control status when changed 

5.5. Target Temperature 
[F1 MT ?] What is the Maximum Target temperature setting allowed for this holder? 
...[F1 MT 110] The maximum target temperature allowed is 110 ºC. 
[F1 LT ?] What is the Lowest Target temperature setting allowed for this holder? 
...[F1 LT -40] The lowest target temperature allowed is -40 ºC  
[F1 TT S 23.10] Set the Target Temperature to 23.10 ºC. 
 Note:  The TC 1 or TC 1B does not turn temperature control on when TT is 

received (as it does when the front panel controls are used to set the TT).  
[F1 TT ?] What is the current target temperature? 
...[F1 TT 71.32] Target temperature is 71.32 ºC. 
[F1 TT +] 

  or [F1 TT R+] Turn on automatic reporting of the target temperature when changed by a 
command. 

[F1 TT -] 

  or [F1 TT R-] Turn off automatic reporting of target temperature changes. 
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5.6. Instrument Status 
[F1 IS ?] What is the current Instrument Status?    
...[F1 IS 0-+S] Response is four parameters (or five, see below):    
   number of unreported errors is 0 (0 or 1);   
   stirrer is off (+ is on, - is off); 
   temperature control is on (+ is on, - is off);   
   current sample holder temperature is stable (S is stable, C is changing). 
  
[F1 IS +] Automatically report instrument status whenever it changes  
  or [F1 IS R+]   (e.g., when the sample holder temperature goes from changing to stable). 
[F1 IS -] 
  or [F1 IS R-]  Stop automatic reports of instrument status when it changes (the power-on 

default). 
  
[F1 IS E+] Include the ramp status as a fifth parameter in the instrument status response.   
...[F1 IS 0-+SW] The ramp status will be one of three states represented by the characters 

 ‘-‘ (minus),  ‘+‘ (plus) or ‘W‘.  See command class 10 for details. 
[F1 IS E-] Stop including the ramp status in the instrument status response (power-on 

default). 

5.7. Current Sample Holder Temperature 
[F1 CT ?] What is the Current Temperature of the sample holder?   
...[F1 CT 22.84] The current temperature is 22.84 ºC.    
[F1 CT +3] Periodically report current temperature every 3 seconds.  
[F1 CT -] Stop periodic current temperature reports. 
[F1 CT +] Restart periodic probe temperature reports using the current interval (the power-on 

default is a 3-second interval). 
 
[F1 CT R+] Report status of the sample holder temperature when it changes. 
...[F1 CT C] The status of CT is changing. 
...[F1 CT S] The status of CT is stable (CT has stayed within +/-0.05 °C of the target 

temperature for at least 1 minute. 
[F1 CT R-] Stop reporting changes in the status of CT (power-on default). 

5.8. Error Reporting 
 

[F1 ER ?] Report the current error (ERror). 
...[F1 ER -1] No current error. 
...[F1 ER 05] Cell T out of range (Loose cable? Sensor failure?). 
...[F1 ER 06] Cell and heat exchanger T out of  range (Loose cable?). 
...[F1 ER 07] Heat exchanger T out of range (Loose cable? Sensor failure?). 
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...[F1 ER 08] Inadequate coolant (check  flow).  Temperature control has shut down.  

...[F1 ER 09] <<bad command>>]  

 Syntax error on a preceding command where “bad command” is the text 
of the command that caused the syntax error response.  

[F1 ER +] Automatically report errors when they occur. 
[F1 ER -] Stop automatic error reports (this setting have no effect on ER 9 responses). 

5.9. Probe Status and Temperature 
 

[F1 PS ?] What is the Status of the TC 1 or TC 1B external Probe connector? 
...[F1 PR +] A series 400 thermistor probe is connected. 
...[F1 PR -] No probe is connected. 
[F1 PS +] Enable probe status to be Reported automatically when a probe is 
  or [F1 PS R+]   installed or removed. 
[F1 PS -] 

  or [F1 PS R-] Disable automatic sending of probe status (power-on default). 
 
[F1 PT ?] What is the current Probe Temperature? 
[F1 PT +3] Periodically report the probe temperature every 3 seconds (integers only, the ‘+’ is 

required). 
...[F1 PT 22.37] The current probe temperature is 22.37 °C. 
...[F1 PT NA] Probe temperature is not available.  
[F1 PT -] Stop periodic probe temperature reports.  The interval is retained. 
[F1 PT +] Restart periodic probe temperature reports using the current interval (the power-on 

default is 3 seconds). 
 

[F1 PA S 0.5] Set the temperature interval for Automatic reporting of the Probe temperature 
   to 0.5  °C during a ramp. (Increment must be positive,  
   without sign in tenths between 0.1 and 9.9 °C, and will 
   work for ramps going up or down.) 
 Note:  this command does not start automatic reporting, it just sets the interval to 

be used when it is turned on. 
[F1 PA ?] What is the current temperature interval for automatic reporting? 
[F1 PA +] Start automatic reporting of probe temperature at temperature 
   intervals (set by the command above). 
[F1 PA -] Stop automatic reporting of probe temperature every temperature 
   increment. 
 
[F1 PX +] Change probe temperature returned to a precision of 0.01 °C. 
[F1 PX -] Change probe temperature returned to a precision of 0.1 °C. 
 
Note:  Since probe temperatures are always reported to 0.01 °C by the TC 1 or TC 1B controller, these 

commands have no effect.  They are included to maintain compatibility with customer software / 
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firmware based on the older TC 125, TC 225 and TC 425 temperature controllers (i.e., they will not 
cause an [F1 ER 9 <<….>>] report – see command class 8). 

 
Note:  Except for [F1 PS ?] and [F1 PS R(+/-)], any probe related command issued when a probe is not 

connected to the TC 1 will result in the warning response [F1 NOPROBE]. 

5.10. Temperature Ramping 
 
[F1 RR S 0.50] Sets the ramp rate to 0.50 °C/minute.  This command also sets the ramp status to 
’W’/ waiting mode (see below).  With the exception of 0 the ramp rate must be in the range 0.01 to 10; 
otherwise an ER9 reply will be returned by the controller, the ramp rate will be set to the nearest allowed 
value, and the controller will send a second response specifying the ramp rate that was set. 

 
[F1 RR S 0]   

   or [F1 RR -] Sets ramp status to ’-’/off (but does not change the current ramp rate setting).    
If either command is sent during a temperature ramp, the controller will then 
drive at maximum to the last set target temperature. 

[F1 RR +] Set ramp status to ’W’/ waiting mode. 
In waiting mode the TC 1 or TC 1B is waiting for a new target temperature to be 
set (see command class 5).  When the TT command is received, if temperature 
control is on (see command class 4) the controller begins ramping the 
temperature from the current value to the new TT at the previously specified 
ramp rate.  If temperature control was off when the TT command is received, 
the ramping process does not begin until it is turned on.  In either case the 
ramping state is ’+’/on until the ramp is completed or cancelled.  

 If this command is sent while a ramp is in progress, the ramp status will change to 
’W’/ waiting and the controller will drive at maximum to the last target 
temperature set. 

[F1 RR ?] What is the current ramp rate setting?  Depending on the R+/R- state as specified 
below, the ramp status ( ’W’/waiting, ’+’/on or ’-’/off) may also be reported. 

...[F1 RR 1.00] Current ramp rate is 1.00 °C/minute. 

...[F1 RR W] Ramp status is waiting. 
[F1 RR R-] Turn off automatic reporting of the rate and ramp status when changed by 

command or by use of the front panel. 
[F1 RR R+] Turn on automatic reporting of ramp changes.  Automatic reports will be sent by 

the controller when the ramp rate or status is changed by command. 
The power on default setting is to not report the ramp rate or the ramp state when changed. 
If you then send [F1 RR R+], only the ramp rate will be reported when changed. 
If you then send [F1 RR R+], both the rate and the state will be reported when changed. 
If you then send [F1 RR R-], neither the rate nor the state will be reported when changed (back 

to the power on default setting). 
Note that the [F1 RR ?] will always result in a ramp rate response.  The ramp status response will 

also be sent if it has been enabled as described above. 
 

The following seven commands, are accepted by and work with the TC 1 or TC 1B.  They are provided 
mainly to maintain compatibility with control software/firmware developed for use with the older TC 
125/225/425 family of temperature controllers.  
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There are no corresponding reference commands (see command class 13) for the TL commands. 
[F1 TL +] Ramp the sample and reference identically. 
[F1 TL -] or. 
      [F1 TL 0] Ramp the sample and reference independently (the power on default). 
 
[F1 RS S #],  [F1 RS ?] Set or query the RS parameter (# is a positive integer). 
[F1 RS S #],  [F1 RS ?]  Set or query the RT parameter (# is a positive integer). 

RS and RT provide an alternate method of setting the ramp rate.   
If the last set command for RS or RT results in both set to positive values (even if the actual 

setting is not changed by the command), they are used to calculate RR for actual use by the 
firmware and the ramp status is set to ‘W’/waiting. 

If ramp status is ‘W’/waiting or ‘+’/ramping, setting both RS and RT to 0 will change the status to 
‘-‘/off (but will not change the ramp rate setting). 

To Ramp the temperature:  
1.  equilibrate at the starting temperature; 
2.  set the ramp rate;  
3.  set a new target temperature (command class 5). 

The target temperature may be above or below the current temperature; as soon as it is set, the ramp will 
begin, up or down, to that new target. 

After reaching the target, the controller will hold at that temperature.  At any time a new ramp rate and target 
temperature can be set to start a new ramp. 

Once the ramp is completed, if you want to start another ramp (even using the same ramp rate) you must 
send ramp rate set command.  Otherwise, setting a new target temperature later will initiate a ramp to that 
target temperature. 
 

Note:  The following details aid in running T-App.  

17. The minimum settable ramp rate (using the [F1 RR S #] command) is 0.01 °C/minute.  The maximum 
is 10 °C/min. 

18. For higher ramp settings, the observed rate may be lower than that specified or it may be nonlinear 
over part of the temperature range because the maximum possible rate of heating or cooling is 
limited (and dependent on the ramp direction as well as on the temperature). 

19. For compatibility with the TC 125/225/425 family of controllers, when the ramping process is 
completed the controller will send an [F1 TT #] response, where # will be the target temperature used 
to start the ramp.  Depending on automatic reply settings, an [F1 RR -] and/or [F1 IS 0++C-] 
response may also be sent by the TC 1 or TC 1B. 

20. When the ramp status is ‘+’/On, sending a [F1 TT S #] command or a [F1 TC -] command will change 
the ramp status to ‘-‘/Off. 

5.11. Heat Exchanger Temperature 
[F1 HT ?] What is the current temperature of the heat exchanger?  
[F1 HT +3] Start periodic heat exchanger temperature reports every 3 seconds. 
...[F1 HT 39] The current heat exchanger temperature is 39 ºC. 
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[F1 HT -] Stop periodic heat exchanger temperature reports. 
[F1 HL ?] What is the high temperature limit for the heat exchanger? 
...[F1 HL 60] The heat exchanger high temperature limit is 60 ºC. 

In operation with temperature control on, if the HT parameter exceeds HL, the TC 
1 or TC 1B will turn temperature control off.  It will also send [F1 ER 9], [F1 TC -
] and/or [F1 IS …] (with parameter 3 = ‘-‘/minus) depending on the current auto-
reply settings (see below). 

5.12. Cell Changing 
Note:  These commands will have an effect only for a sample holder with multiple cuvette 

positions. 

[F2 DI] Device initialize: move to home position. 
[F2 PI] Device initialize: move to home position and reply when 
   done. 
...[F2 DL 1] Device is finished moving.  (Original reply was OK rather than DL 1) 
[F2 DL 3] Device locate: move to position 3.  (Device should be 
   initialized prior to using this command for the first time.)  
[F2 PI] Device initialize: move to home, then to position 1 and reply when 
   done. 
...[F2 DL 1] Device is in position 1. 
[F2 PL 4] Device locate: move to position 4 and reply when done.  (Device should be 
   initialized prior to using this command for the first time.) 
...[F2 DL 4] Device is now in position 4. 
[F2 DD 400] Set speed to 400 (acceptable range 100 – 900, with a default of 500). 

5.13. Reference Cuvette 
 

Note:  These commands will have an effect only for systems with two independently-controlled 
sample holders. 

 
[R1 ...] 
 
To control and monitor the temperature and status of the reference cuvette using a Dual Temperature 
Controller, use any commands in classes 3-8, 10 and 11, substituting R1 for F1.  There are no corresponding 
[R1 …] commands for command classes 1, 2, 9 and 12. 
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5.14. Front Panel Controls 
 

Note:  The TC 1 or TC 1B can be controlled manually using the buttons and the display on the 
front.  Once a control program has connected to the TC 1 or TC 1B, the controller will 
automatically send reports to the program whenever a manual change has been made.  The 
commands in this section allow the program to control access to front panel (FP) settings and 
determine if and how such front panel changes are reported. 

 
[F1 LO (+/-)] LockOut (+) or do not lockout (-) the front panel.  When lockout is on (+) the front 

panel will display “LOK” or “LLK” in the upper right corner of the display.  The 
user will be able to use the left-arrow and right-arrow button to move between 
the settings displays (as if no control program was connected) but the up-arrow, 
down-arrow and SET buttons will not allow changes in the settings.  The up-
arrow and down-arrow buttons will work to move between the main “SAM”, 
“REF” and version/ID displays. 

[F1 LO ?] Query the current lockout state. 
...[F1 LO +] or ...[F1 LO -] 
 
[F1 LK (+/-)] LinK (+) or unlink (-) the reference to/from the sample.  This command is only 

available for a dual sample holder system.  When link is on (+) the front panel 
will display “LNK” or “LKK” in the upper right corner of the display.  The user will 
be unable to change any of the REF settings (they will be locked as described 
above).  When the user changes a “SAM” setting using the front panel controls 
(such as temperature control On/Off, stirrer speed, ramp rate) the identical 
change will automatically be made for “REF’. 

[F1 LK ?] Query the current link state. 
...[F1 LK +] or ...[F1 LK -] 
 
 T-App uses this command to turn linking off in the temperature controller and 

handles linking of the reference settings to the sample settings in the program 
(see link reference to sample). 
 
“LKK” in the upper right corner of the display indicates that both lockout and link 
have been turned on by the control program.  Note:  Do not attempt to run a 
control program with the temperature controller in linked mode; that capability is 
not available at the current time.  Only use the [F1 LK -] command to make sure 
the controller is not in linked mode. 

 
[F1 FP (+/-)] Report (+) or do not report (-) changes made by use of the Front Panel controls on 

the TC 1 or TC 1B.  The power-on default is to report FP changes. 
 Setting changes are reported by [F1 TT #], [F1 SS #] and [F1 RR #] replies. 
 The power-on default for status changes is to report by [F1 TC (+/)], [F1 SS (+/)] or 

[F1 RR (+/)] replies, even if the control program has not turned these status 
change replies.  The control program cannot turn these responses off (except 
as described below). 

 If the control program has sent [F1 IS +] or [F1 IS R+] commands to turn automatic 
instrument status reports on, status changes resulting from use of the front 
panel controls will be reported only by the instrument status reply, [F1 IS ….]. 

 There is no query command for the FP state. 
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6. Elements of the T-App Software Help File 
The program T-App comes with a complete Help File.  Below are elements useful for getting started with T-
App. 

6.1. Application Startup Window  
This Startup Window is displayed while the program searches for a Temperature Controller by checking 
each active COM port on the computer, beginning with the highest. 
 

 
 

When a Controller is found, this startup window is replaced by the Application Control Window. 
 

If a Controller is not found, the startup window changes to that below. Click on the areas where the pointer 
changes to a hand for further information on the Application Menus and buttons, 
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This may result if the Controller is not connected to power, or if the Bluetooth or USB link between the 
Controller and the computer is not available. 

Click the Try Again button (or use the File>Restart menu item) once you have corrected the problem. Click 
the Exit button (or use the File>Exit menu item) to terminate the program. 

You may also use the File>(Work Offline) menu item to use the program without connecting to a sample 
holder in order to plot previously saved time/temperature data without being connected to a Controller. 

6.2. Application Control Window 
Click on the areas where the pointer changes to a hand for further information on the Application Menus, the 
Temperature Plot or the Status Panel. 
 

 
 

The image above shows the T-App Application window as it would appear using a TC 1 or TC 1B 
Temperature Controller with a Series 400 thermistor probe attached (with the thermistor tip in the stirred 
sample). For other configurations (dual sample holders; multi-cell holders; TC 125, 225 and 425 
temperature controllers) see the Status Panel topic. 
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6.3. Application Menus 
Click on the individual menu bar items (where the pointer changes to a hand) for further information on that 
menu. 
 

 

6.4. File Menu 
Click on the individual menu item (where the pointer changes to a hand) for further information on that menu 
item. 
 

 

6.5. Tools Menu 
Click on the individual menu item (where the pointer changes to a hand) for further information on that menu 
item. Tools menu items for a single sample holder system. 

 

6.6. Temperature Control 
Tools>(Temperature Control) menu for a single controller, including multi-position controllers. 

 



 
 

  9/21/2022  
  

Page 35 of 45 

QNW TC 1B User’s Guide 

6.7. Temperature Ramping 
Single sample holder system. 

 

6.8. Stirrer Control 
Single sample holder system. 

 

6.9. Show Script Panel 

 
See also the Hide Script Panel menu item. 

When this menu item is clicked, the right side of the Application Control Window will open to show a vertical 
panel containing a text display with button controls and other information near the bottom. 

The snapshot below was taken when the program was in the middle of running a script. This particular script 
is used to do a performance run on each sample holder (the performance run for each sample holder is 
included as the last page in the hardware manual). 
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When the Show Script Panel opens, the initial text display will be empty and the bottom controls appear as 
shown below left. Below right show the same area while a script is running (identical to that in the snapshot of 
the full window above). 

The controls at the bottom of the script panel change depending on whether a delay or wait command is being 
executed and on whether the current command being executed is inside a loop.  Click on the individual 
control below (where the pointer changes to a hand) for further information on that control. 

 
 

  

NO SCRIPT RUNNING. DELAY/WAIT COMMAND NOT INSIDE A LOOP. 

 
 

  

CURRENT COMMAND IS INSIDE A LOOP.   DELAY/WAIT COMMAND INSIDE A LOOP. 
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6.10. Command Text Box 
This edit box may be used to send commands to the Temperature Controller. The command format is 
illustrated by the default entry, [F1 CC P1 P2]. 

Replace "CC" by the command code. 

Replace "P1" and "P2" by the command parameters. Most commands require only one parameter; in that 
case delete "P2". 

Clicking the arrow at the right end of the edit box will cause a drop down list to appear showing a few valid 
commands.  

For example, immediately after the program is started the text box will look like the figure below. 

If you click on one of the items in the list, that item will appear in the box at the top and the list will 
disappear. You may then edit the command as needed. You may also enter a command that does not 
appear in the list. 
 

 

6.11. Plot Menu 
Click on the individual menu item (where the pointer changes to a hand) for further information on that menu 
item. 
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6.12. Data Shown 
Dual with external probe 

 
Single (or multi-sample) with external probe 

 

6.13. Single Sample Status Panel 
Click on the individual controls where the pointer changes to a hand for further information on that control. 
 

WITHOUT PROBE ATTACHED WITH PROBE ATTACHED  
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6.14. Temperature Control Status 

   
When temperature control is off, the circle will be a steady gray and the label will read "off". 

When temperature control is on but the sample holder temperature is not stable, the small circle will alternate 
slowly between green and gray and the label to it's right will read "seeking". 

When temperature control is on and the sample holder temperature is stable, the circle will be a steady green 
and the label will read "holding". 

If an error condition occurs that causes temperature control to be turned off the circle and the caption to its 
right will alternate rapidly between red and gray. 

 

6.15. Heat Exchanger Temperature 
 

 
The temperature of the heat exchanger in the sample holder is displayed here. 

The heat exchanger temperature is dependent on the temperature and the rate of flow of the water being 
circulated through the sample holder and on the temperature control settings. 

As a warning, when the heat exchanger temperature is within 10 °C of the preset limit (typically 60 °C, the 
color of the label will change to orange. To correct the problem, you must reduce the temperature of the 
water (for example, by adding ice or cold water to the coolant container). 

If the heat exchanger temperature exceeds that preset limit, temperature control will automatically be turned 
off to prevent damage to the system. 

If temperature control does turn off, the label will turn red and an error message will display below the menu 
bar as illustrated below; also, the Temperature Control Status will show the error number and begin flashing 
red. The error message (and the flashing of the status control) can be removed at any time by clicking on 
the Clear button to the left of the message. 

Once the problem with the heat exchanger temperature is corrected, you can restart temperature control by 
clicking on the Temperature Control On/Off checkbox or using the menu item Tools>(Temperature 
Control)>On. 
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6.16. Target Temperature 

 
The Target Temperature is the Sample Holder Temperature that you want to use. If Temperature Control is 
On, the Controller will either be driving the holder temperature to the target or maintaining the holder 
temperature at the target. 

The number displayed is the current Target Temperature. When the Change button to the right of the 
number is clicked a small parameter entry dialog will appear where you can change the Target Temperature 
setting. 

The Tools>(Temperature Control)>(Set Target) menu item may also be used to change the Target 
Temperature. 

6.17. Magnetic Stirrer Controls 
 

 
The checkbox may be used to turn the magnetic stirrer on (checked) or off (unchecked). 

Click on the Change button to reset the speed of the stirrer. The current speed setting is shown to the left of 
the button. The submenus of the Tools>(Stirrer Control) menu item may also be used to change the stirrer 
properties. 

6.18. External Probe Status 
The External Probe Status will be displayed only if a Series-400 or Series-500 thermistor probe is connected 
to the 1/4 inch phone jack in the back of the sample holder. This probe input is intended to provide a means 
to directly measure the temperature of the sample in the cuvette. 
 

   
The number to the left of the Avg checkbox is always the most recent temperature from the probe. If a probe 
temperature is not yet available, the digits will be replaced by dashes. 

The left image shows the display for when the Avg box is not checked.. 

When the Avg checkbox is checked (by clicking on it), all controller models send probe readings with two 
decimal digits. The numbers in parentheses beneath the checkbox (middle image) list the mean value of the 
most recent 20 temperatures for the probe followed by the average deviation from that mean. The mean 
value should provide a more reproducible sample temperature if it has been stable long enough for 20 
temperatures from the stable period to have been acquired. 
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If 20 temperatures are not yet available, the mean and average deviation are replaced by dashes (image on 
the right). 

6.19. Plot Axis Label Manipulation 
The label on the vertical axis can be changed by clicking on the small black rectangle near the upper-left 
corner of the plot; this will make a text box appear for changing the label.  After new text has been entered, 
hitting the Tab or Return key will cause the text box to close and the modified axis label to appear on the 
plot. 

 

 
BEFORE CLICKING ON THE BLACK RECTANGLE.  AFTER CLICKING ON THE BLACK RECTANGLE. 
 

The label on the horizontal axis can be changed by clicking on the small black rectangle near the lower-right 
corner of the plot; this will make a text box appear for changing the label.  After new text has been entered, 
hitting the Tab or Return key will cause the text box to close and the modified axis label to appear on the 
plot. 

 
BEFORE CLICKING ON THE BLACK RECTANGLE. AFTER CLICKING ON THE BLACK RECTANGLE 

6.20. Plot of Data Collected 
This plot shows an example of temperature as a function of time data that would result from using the 
Example Script. 
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black - temperature of the sample holder. blue - temperature of the heat exchanger. 

dotted black - temperature of the external probe (with the thermistor tip in the liquid sample).  

Individual time/temperature points are shown for the external probe data to illustrate special methods of 
reporting probe temperatures used in the Example Script. Normally the probe data are shown as a red line. 

6.21. Scripts: Program Script Commands 
 

The Program Script Commands are used to control the behavior of a script and are not sent to the QNW 
Serial Controller. 
 
Delay and Wait commands 

Progress of the Delay and Wait commands is tracked in the Delay/Wait Countdown Display at the bottom of 
the Script Panel. 
[*D #] - Delay # INTERVALS before running the next command.  Example: [*D 120] will cause a delay of 120 
of the INTERVAL units as defined in the first line of the script (see the Example Script which sets the 
INTERVAL to 0.01 minutes). 

While the delay is active, a countdown of the number of script INTERVALs remaining is included in the 

Countdown Display (see Window View 2 in the Script Panel). 
[*WRP>=#] [*WRP<=#] These commands are included to be compatible with older scripts.  T-App now 
interprets them as [*WCT>=#] and [*WCT<=#] 
[*WCT>=#] - Wait until the current (holder) temperature exceeds or equals a particular value (# as an 
integer). 

[*WCT<=#] - Wait until the current temperature decreases to or below a particular value (# as an integer). 
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The current temperature is the temperature of the metal body of the sample cuvette holder. 

[*WPT>=#] - Wait until the probe temperature exceeds or equals a particular value (# as an integer). 

[*WPT<=#] - Wait until the probe temperature decreases to or below a particular value (# as an integer). 

The probe temperature is the reading of the standard 400 series or 500 series probe (usually the probe is 
inserted in the sample cuvette). 

[*WRT>=#] - Wait until the reference temperature exceeds or equals a particular value (# as an integer). 

[*WRT<=#] - Wait until the reference temperature decreases to or below a particular value (# as an integer). 

The reference temperature is the temperature of the metal body of the reference cuvette holder (dual 
controller only). 

[*WT 1000 2] wait for stable T (or 20 min max) 

[*WT #] -  This command will be interpreted as a [*WT 1000 1] command to maintain compatibility with older 
script files. 

[*WT (#1) (#2)] - This program command will cause the script to Wait until the sample holder Temperature 
is stable before continuing to the next script command in the list. Temperature stability is determined by an 
algorithm built into the QNW Temperature Controller. The parameter (#1) determines how often the 
program sends a status query to the controller ( [F1 IS ?], see the Controller Serial Command List). Each 
time this query is received, the controller returns a status reply which includes information as to whether the 
temperature is still changing or has met the criteria for being stable (controlled). The parameter (#2) 
specifies the maximum number of status queries that will be sent before the wait is canceled. 

The time between status queries is the product of the parameter (#1) and the script INTERVAL as defined in 
the second line of the script (see the Example Script). 
While the wait is active, the number of times the controller has been queried is displayed followed by a 
countdown to the next query. 

Note: if the command [F1 IS +] has been sent to the controller, the the instrument status reply will be sent by 
the QNW Temperature Controller automatically when the sample holder temperature becomes stable. In 
this case the command form [*WT (#1) 1] is recommended where (#1) is chosen to give a 10 minute period 
(for example, if INTERVAL IS 0.6 seconds or 0.01 minutes, then (#1) should be set to 1000). Typically, 
stable sample holder temperature is attained within 10 min of setting a new target temperature. 

[*WD #] -  This command is no longer accepted because it does not work in Windows XP or later. 

 

Beep Control commands 

[*BCT +] or [*BCT-] -  Turn on(+) or off(-) beeping by the computer whenever a sample holder (current) 
temperature report is received from the controller. 

[*BPT +] or [*BPT-] - Turn on(+) or off(-) beeping by the computer whenever a probe temperature report is 
received from the controller. 

[*BRT +] or [*BRT-] -  Turn on(+) or off(-) beeping by the computer whenever a reference holder temperature 
report is received from the controller. 

 
Warning Control commands 

 [*E+] or [*E-] -  The commands are no longer supported because they are not needed for T-App version 
2.21. 
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Listing Control commands 
 

[*LIS +] or [*LIS -]  - Enable (+) or Disable (-) listing of Instrument Status replies during running of a script. 

[*LER +] or [*LER -] - Enable (+) or Disable (-) listing of Error Message replies during running of a script. 

[*LCT +] or [*LCT -]  - Enable (+) or Disable (-) listing of Current Temperature replies during running of a 
script. 

[*LPT +] or [*LPT -] - Enable (+) or Disable (-) listing of Probe Temperature replies during running of a 
script. 

[*LRT +] or [*LRT -]  - Enable (+) or Disable (-) listing of Reference Temperature replies during running of a 
script. 

These ten program commands can be used to control whether the indicated information, sent from the Serial 
Controller to the program, are to be listed (displayed) in the Script Panel or the Command Panel while a script 
is running. Disabling the listings may be useful to make progress of the script clearer since, under some 
conditions, large numbers of Instrument Status replies and Temperatures replies may be generated while the 
script is running.  Disabling affects only the listing of these various replies -- the replies will still have their 
normal effects in the Main Window. 

Note:  some earlier versions of T-App defaulted to listing temperature replies in the Command/Script panel.T-
App version 1.51 defaults to not listing them. 

 

Miscellaneous commands 

[*R] -  This program command is used only at the end of a script.  It will cause the script to be repeated, 
starting at the beginning. The script will then repeat forever or until the Cancel Script button is clicked. 

[*P]  - If the plot window is displayed while a script is running, the data in the plot mayl not be automatically 
updated unless a delay (*D) or wait (*W) command is being processed. This program command will cause 
the plot window to update (replot to show all data collected to that point). 

[*CTD] - This command will clear the time and temperature data from the Time/Temperature Plot of the 
Application Control Window. In addition, the time parameter in the displays will be restarted at zero and 
listing of time/temperature data in the display windows will be started. Whatever display interval was in effect 
at the time this command is executed is retained (set by a script command or by clicking on the (Plot>Set 
Interval) menu item). 

[*MSG + message] or [*MSG - message]  - This command will stop execution of the script and present a 
dialog box containing the second command parameter ("message"); change this parameter to the wording 
you want the dialog box to display. The first parameter (+ or -) determines whether the computer beeps (+) or 
not (-) while the dialog box is visible. Clicking on the "OK" button in the dialog box closes it and execution of 
the script continues. 

[*LS #] and [*LE] - The [*LS #] command defines the start of a loop (a repeat of a series of commands) within 
the script; the parameter '#' is an integer specifying how many times the loop is to be run. The [*LE] 
command defines the end of the series of commands included in the loop. A script may contain more than 
one loop. Also, smaller loops can occur within larger loops. 

[*WPL] -- When the positioning commands [F2 PL #] = go to position # 

or [F2 PI] = go to home and back to the last position 
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are sent to the Temperature Controller, it automatically sends the reply [F2 DL #] when the positioning 
process is completed.  The [*WPL] command waits for this reply before continuing to the next command in 
the script. 

[*PL+] -- This command will cause the sample position to change to the next higher number. If the current 
position is the highest number position, it will move to position 1. 

[*PL-] -- This command will cause the sample position to change to the next lower number. If the current 
position is 1, it will move to the highest number position. 

[*TT+#] or [*TT-#] -- Increments or decrements the sample holder target temperature. 

[*RT+#] or [*RT-#] -- Increments or decrements the reference holder target temperature. 
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